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Objetivo: Utilizar o display de 7 segmentos do PLD para uma simples
contagem de 0 a 9 utilizando um decodificador 7448.

DISPLAY DE 7 SEGMENTOS
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Objetivo: Utilizar o display de 7 segmentos do PLD para uma simples
contagem de 0 a 9 utilizando um decodificador 7448.
O display de sete segmentos, é formado por sete leds, dispostos em

forma de oito. Quando se necessita de acendero numero “0”, ligam-se os
leds correspondentes ao digito “0”, por exemplo, os segmentos a, b, c, d,

e, f
S segmentos de saida
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Um dispositivo electrénico muito usado com os displays de 7 segmentos é o
descodificador BCD-7segmentos. O descodificadortem a fungéo de
interpretarum codigo (BCD) e gerar os sinais para ligar o digito
correspondente a este codigo no display de 7 segmentos.

Porexemplo:
Entrada do descodificadorem BCD (Decimal Codificado em Binario)— 0000
Saida do descodificadorpara o display de 7 segmentos -0111111-gfedchb

a
0
0 ] 1 Saidado
Foimdade 0 (Wescodficads 1 descodificador para
descodficador ¢ BCD - 7segmentos 1 o display de 7
(0 emBCD) o | 1 -
0 1  segmentos (digito 0) l—l
1

Note que a saida do descodificadorcorresponde aligar os segmentos do
digito “0” de um display do tipo catodo comum.

Os descodificadores comerciais disponiveis s&o: 7447 (dnodo comum) e

7448 (catodo comum).
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Passo a passo

Iniciar um Novo Projeto

Para comecar a trabalhar em um projeto novo, primeiro temos que definir um
escopo para este projeto. O “software” Quartus |l facilita esta tarefa

fornecendo suporte na forma de um Assistente (“Wizard”). A criagdo de
um Novo Projeto segue as etapas detalhadas a seguir.

a) Selecionar File > New Project Wizard para iniciar o Assistente de Novo
Projeto o qual direciona a criagdo e configurages preliminares de um Novo
Projeto.

b) Na janela “New Project Wizard: Introduction” , clicar em Next.
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Janela “New Project Wizard: Add Files”. O Assistente de Novo Projeto
permite incluir arquivos pré-existentes (se houver) no Projeto.

Mow Projoct Wizard: Add Filas [page 2 of 5] ==}
Sebect the desion fles wou werk tnindlude i e moiect. ClokAdd Al o add 2 desig fies in fae
prcject disckon o the ogect. Moks: you can abesgs sl desgn fils o b progec) Gle
G | N
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Na janela “New Project Wizard: Family & Device Settings”:

f.1) Especificar o tipo de dispositivo no qual o circuito projetado sera
implementado.

No campo “Device Family — Family:”, escolher Ciclone IVE como Familia do
dispositivo de destino.

f.2) Pode-se deixar o “software” Quartus Il selecionar um dispositivo especifico
na familia, ou podemos escolher o dispositivo explicitamente. Utilizaremos esta
Gltima abordagem

No campo “Target device” escolher a opgao “Specific device selected in
‘Available devices’ list”.

f.3) No campo “Available devices” aparece uma lista de dispositivos
disponiveis, escolher o dispositivo denominado *que éum
PLD utilizado na Placa Didatica de Desenvolvimerd

K kroton
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@4 New Project Wizard =)
— a
Family & Device Settings [page 3 of 5]
Select the family and device you want to target for compilation.
You can instal additional device support with the Install Devices command on the Tools menu
To determine the version of the Quartus II software in which your target device is supported, refer to the Device Support List webpage.
Device family Show in 'Available devices' st
Family: [Cyclone 1v E - Package: [any -
Devices: (Al -] Pncount: [any B3|
Target device Core Speed grade: [Anv - ]
() Auto device selected by the Fitter Name filter:
@) spedific device selected in ‘Available devices' list Show advanced devices
Other: nja
Avalable devices:
Name Core Voltage LEs User I/0s Memory Bits Embedded multiplier 9-bit elements PLL ~
EPACE7SF2II7 v 75408 293 2810880 400 4
EP4CE7SF23I8L Lov 75408 293 2810880 400 4
EP4CE7SF29CE 1.2V 75408 427 2810850 400 4
EPACETT 297 427 2310330 oo & |
EPACE7SF29CB L 708 427 2310880 400 4
EP4CE7SF29CBL Lov 7408 427 2810880 400 4
EP4CE7SF29COL Lov 7408 427 2810880 400 e
EPACETSF29I7 v 7408 427 2810880 400 4
EPACE7SF2918L LoV 75408 427 2810880 400 4 2
il i v
<Back | [ next> |[ Fmsh ][ cancel ][ nep |
¢
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Resumo das Configuracdes escolhidas:

>Q.NemeJc(lW|zmd .’L---_' b —— T T g

Project directory:
Project name:
Top-evel design entity:
Number of fies added:
Number of user ibraries added:
Device assignments:
Family name:
Device:
EDA tools:
Design entry/synthesis:

Summary [page 5 of 5]

When you clik Firish, the project wil be created with the following settings:

Cilaltera\14.0
aulal

aulal

0

0

Cydone IVE

EPACETSF29C7

<Nene> (<Nene>)

Smulaton Modelsin-Altera (4HDL)
Timing analysis: 0
Operating conditions:
VCCINT voltage: 1
Juncton temperature range: osseC
[ eBack ][ wet> |[Fmsh | [ concal ][ mep ]
11
& Quartus I 64-8it - Cyaltera/140/aulal - aulal Wi woe
FieEdtViemejectAﬁgmmtstcsshgTookWndowHebé_ﬂ
DEH@ $ @B 9 o (o RIS
|Project Navigator 28 x
T QUARTUS? Il SOFTWARE v13.1:
GET THE COMPETITIVE EDGE WITH THE
A cydone IV E: EPACE7SF29C7 STES
> aula1 S
&He{ardw
Tasks
Flow: [f'
4 Compile Design
b B Analysis & Synthesis
> B Fitter (Place & Route,
S T
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Para descrever o circuito no formato de Captura de Esquematico deve-se uwsar o Editor
Grafico do Quartus II. conforme as etapas detalhadas a seguir.

a)  Selecionar File > New para obter a janela da Figwa 14. Escolher “Block Diagram /
Schematic File” e clicar em OK. Isso abre a janela do Editor Grafico (Figural5).
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b) O primeiro passo é especificar wn nome para o arquivo que serd eriado. Selecionar File

> Save as ... que abre a caixa de didlogo mostrada na Figura 16.

b.1) No campo “tipe:” a opgio Block Diagram/Schematic File (*. bdf) deve estar
selecionada.

b.2) O campo “mame:” deve conter o nome do arquive. o mesmo nome dado ao
arquivo que foi especificado quando o projeto foi eriado.

b.3) A opgdo “Add file to current Project™ deve estar selecionada.

b4) Clicar em “Salvar’. o que armazena o arquivo no diretério
C:lAlunos|dula_02\Nome 122100010 ¢ leva a jancla do Editor Grafico exibida
na Figura 17.
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O Editor Gréfico oferece uma série de bibliotecas que incluem elementos
de circuito que podem ser importados para um esquematico. D& um duplo
clique no espagco em branco na janela do Editor Grafico, ou clique no
icone na barra de ferramentas que se parece com uma porta AND .

1r

Va4 em “libraries”, em seguida, expandir a biblioteca “primitives”,
seguido de expansédo da biblioteca “logic” que compreende as portas
légicas. Selecione “and2”, que é uma Porta E de duas entradas, e clique
em OK. Agora, o simbolo da Porta E aparecera na janela do Editor
Grafico. Usando o mouse, mova o simbolo para um local conveniente e
clique para coloca-lo Ia. Importar a segunda

v kroton
£ Quarus 16481 - Caera/ 140/l - sl O =
> ghica ®
USH@ % a8 9o [ D[R L TN AT TN NI
Project Nevigatar iax| = BlockLbdf [x] IP Catalog e x
Sy FeARZABS-O1I1INNNNCON ARG d&d 2 s aB 90 a, X =
Ac:nz:u%mnsm - 2 st
+ Project Directory
Basic Funciions
=3
Interface Protacals
y Interfaces and Contrelers
4 Symbel [ i
e R R R N
4 + & a4 dlarusbrares] =
© megafunctions L e face Protocols
Ay riersrcry | ElFe | d|p] gm"‘? ¥ Imerfaces and Contalers
:  © prmmes : . . e .
Tasks AEx © buffer Parter P
e — SEREEEISEY. * Blgc
o [Compitin ] [Gimamieo] 11 9 otz
Task t . f B a2
SESEISES. O s
4 B ConpleDesion & e
B drolyss & Synhess 3
B Fiter Bloce & Route) f—
B assembier Generateprog | =
B TmeQuest Timng Anayss [ 0TI
B EDANetst Ve B
W Program Devics (OpenProgran [ 1111111 ] Insert symibol as biock
|« vl 1
: o (Coma ]
e E @ v
#ltype ID Message

18 kroton

25/05/2017



25/05/2017

A
Aula 9

No PLD construir um conversor 7448 com as saidas para o display de 7
segmentos. New- Block Diagram- C:/ Altera — Others- 7448

Utilizar 4 chaves! Chama-las de Entl, Ent2, Ent3 e Ent4.

CEenl 7448 el
e A OA ¢
Em B OB %
Ew | © o I
. : o oD —

ix——iiiiiiiii}cum o N ECRRRRRRERRRIO
BEEEERERRAD bl P
REEEREEERE b v o N E-REEEERTRETIONS

kroton
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No PLD construir um conversor 7448 com as saidas para o display de 7
segmentos.
“ kroton"
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No PLD construir um conversor 7448 com as saidas para o display de 7
segmentos.

Apos isso, compile e comece a
conectar as entradas e saidas.

Utilizar as chaves SW0 — SW1-
SW2- SW3

E o 1° display.

Consultar a partir da pagina 36
do manual.

74
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Compilar o Circuito Projetado

O arquivo do diagrama esquematico descrito — Luzes_de_Alerta.bdf, sera
processado por vérias ferramentas do Quartus Il que irdo analisar o arquivo,
sintetizar o circuito, e gerar uma implementag&o deste circuito para o chip de
destino. Estas ferramentas sdo controladas pelo programa aplicativo chamado
Compilador.

Para executar o Compilador selecionar Processing > Start Compilation, ou
clicar no icone da barra de ferramentas horizontal.

-

A medida que a compilacéo passa pelos varios estagios, seu progresso
é relatado em uma janela no lado esquerdo da tela do Quartus Il (janela
“Tasks”). O sucesso (ou insucesso) do processo de compilagdo é
indicado em uma caixa de diéalogo,

22 ‘qutonl
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Atribuicdo de Pinos do PLD w

Assignments > Pin Planner

@Qﬂvuiv— W sistemas Digitais I Aula3 final L
=7 wido  Iew  Design | Animsées | Apresentaciodesiides  Rewsio  Bdbigio

. =i | Avang
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H e Symbd_PrType -
i
= ECES g
aEL e "
[ © 1
@ S
— :
4 (& Eary P Plarring & 9 0
| T3 sty Pn Flarring... (3 5 oes
- » Run 1/ Assigment Ansiyss 1] axn
3 T Export Pin Assigrments. . L] axp
By = = O omersy =
] Namedt = ~ (o] ean(x v
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Atribuicéo de Pinos do PLD

Assignments > Pin Planner

P&ag. 38 do Manual

y 4
Aula 9

HEXO[3]

HEXO[6]

Figure 4-10 Connections between the 7-segment display HEX0 and Cyclone IV E FPGA

Table 4-4 Pin Assignments for 7-segment Displays

2 kroton
AN

Table 4-4 Pin Assignments for 7-segment Displays

Signal Name FPGA Pin No. Description /O Standard

HEXO0[0] PIN_G18 Seven Segment Digit 0[0] 2.5V

HEXO0[1] PIN_F22 Seven Segment Digit 0[1] 2.5V

HEXO0[2] PIN_E17 Seven Segment Digit 0[2] 2.5V

/ANOTS RYA\

HEXO0[3] PIN_L26 Seven Segment Digit 0[3] Depending on JP7
HEXO0[4] PIN_L25 Seven Segment Digit 0[4] Depending on JP7
HEXO0[5] PIN_J22 Seven Segment Digit 0[5] Depending on JP7
HEXO0[6] PIN_H22 Seven Segment Digit 0[6] Depending on JP7
HEX1[0] PIN_M24 Seven Segment Digit 1[0] Depending on JP7
HEX1[1] PIN_Y22 Seven Segment Digit 1[1] Depending on JP7
HEX1[2] PIN_W21 Seven Segment Digit 1[2] Depending on JP7
HEX1[3] PIN_W22 Seven Segment Digit 1[3] Depending on JP7
HEX1[4] PIN_W25 Seven Segment Digit 1[4] Depending on JP7
HEX1[5] PIN_U23 Seven Segment Digit 1[5] Depending on JP7
HEX1[6] PIN_U24 Seven Segment Digit 1[6] Depending on JP7
HEX2[0] PIN_AA25 Seven Segment Digit 2[0] Depending on JP7
HEX2[1] PIN_AA26 Seven Segment Digit 2[1] Depending on JP7

26
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Atribuicéo de Pinos do PLD

Assignments > Assignment Editor

Deskiop/Teste/nule] - il — ——_ —— - W

Processng  Tools Window Help 5

T HEY S D ron 0 29 P Ale T

; | 'g# Compiation Report -aulal || | R aulat.bdf B | @  AssgnmentBditor [ ‘
<<new>> v [V]Filter on node names: = - CatEgorv:[Nl -

tatu From To Assignment Name value Enabled Entity Comment Tag
1 /M, Sensor_Porta Location PIN_Y23 Yes

2 « [ % sensor_Cinto  Location PIN_Y24 Yes
3 N o chave..nicao  Location PIN_AAZZ Yes
4+ [ 24 fsensor_Cinto Location PIN_H15 Yes
5 I 4 Led Ports  Location PIN_G15 Yes
5 « I o Led Cinto Location PIN_F15 Yes
7 « [ 22 Alarme Location PIN_H17 Yes
8

<<new>> <<new>> <<new>>
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Programacé&o do PLD

Va em Tools > Programmer > Hardware Setup > USB- Blaster [USB-0]
e add o arquivo. sof
[Ty e———— /e s o L W=

Fie Edt View Processing Toos Window Hep D Search altera,com @

2 Hardnare Setp...] No Hardware Mode: [TTAG v) ragress: |

Enable real-time ISP to allow background programming (for MAX IT and MAX V devices)

e Fie Device Checksum  Useresde  Program/  Verfy  Bank-  Examne
W Start Configure Chedc
i Stop
3 Auto Detect
3 Delete.
[ Add File...
& change Fie.
[ty eerie- ] | g
el Save File

| kroton€
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Programacé&o do PLD

Apos isso clique em start e acompanhe o progresso

L ==

p Programrmer - Cy/Users/Cristiano/Desktop/Teste/aula1 - aulsL - [Chain3.cdf]
Search altera. com @

Fle Edt View Processng Toos Window Hep %

& Hardnare Setup... | No Hardware Mode: [JTAG i Progress:

7] Enable real-time ISP to allow background programmi

Progam/  Verify  Blnk-  Examine
Configure Chedc

Fie Device Checksum Usercode
b start

dostop
4 Auto Detect
X Delete

[ Add File...

& Change File,
|l save File
Thup

J Down

Y .

Aula 9

Utilizar 2 displays

Utilize agora as mesmas ou outras 4 chaves, mas agora para
acionar 2 displays. Cuidado, mudar o nome das variaveis de

saida. Como ficaria?

30 kroton
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